Excel Data Bridge #@ -
Stock Take Function

Introduction

The purpose of the StockTake function in Excel Data Bridge is to allow entry of stock values outside of Sage
200 for existing Stocktake lists.

This function has one template with 3 sheets :-

e All Fields shows all possible fields. Stocktake list values can be entered, stock write off and add stock.

e Minimum Traceable shows essential fields for traceable stock. This sheet allows for stocktake lists to
be completed, stock write off and add stock.

e Non Traceable Stock shows essential fields for non traceable stock. This sheet allows for stocktake
lists to be updated and completed.
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Excel Stock Take
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Status GroupBylD Warehouse Name Narrative Bin ItemCode ItemName

1 FACTORY  DECPAPERSW3 Binl DEC/PAPER/GF DEC/PAPER/GREY/SW
1 Bin2 DEC/PAPER/GF DEC/PAPER/GREY/SW
1
1
1

]

< > AllFields ~ MinimumTraceable  NonTraceableStock — Help & Support 4F

Before starting to enter stock values the relevant sheet must be selected and a download of the stocktake list
must be completed using the Download button from the Excel Data Bridge tab.

To update the data use the Update button. Once stocktake is finished, use the Complete button to close the
stocktake list.
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Map Fields

The table below explains the purpose of each of the fields available to the worksheet: -

Status

GroupByID

Warehouse
Name
VarianceCode
VarianceCC
VarianceDept
Narrative

Bin

Item Code

Item Name
Expected Quantity
Actual Quantity
WriteOffCategory

Discrepancy
Narrativeltem
CountSheetltemID

TraceableType
IdentificationNo

CountSheetTraceltem!D

The following fields can be found on all sheets

Populated when selecting either the Update or
Complete buttons on the Excel Data Bridge ribbon.

¢ The default status on a successful validation will
be Pending

* The default status on a successful creation will be
Processed

When attempting to send data to Sage 200, the
status field should either be cleared, or display a
status of Pending. Any other data entered in this
field will prevent the data being sent to Sage 200.

Should an error be returned in this cell when
attempting to post, it will appear in red. The error
should be corrected in the worksheet, and the
status field cleared before attempting to send again

Group by ID will auto populate based on the
stocktake list.

The warehouse code

The stocktake name

The variance code

The variance cost centre

The variance department

Enter narrative field if required

Bin number

Displays item code

Displays item name

Displays expected quantity. This field is read only

Enter quantity

Only populate if you are taking away stock. Browse
function shows write of categories. Ensure to enter
a 0 in ActualQuantityTraceable for serial number
being written off. When writing off stock it will
appear after completion in the nominal write off
section.

True or False

Enter narrative field if required

This field auto populates. Can be hidden but
currently mandatory.

Displays the way the item is traceable

When adding stock enter the identification number
such as serial number.

This field auto populates.
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ActualQuantityTraceable Enter quantity

AddNew If stock is added change to TRUE for new lines

UnitCostPrice Enter unit price for new stock

Referenceln Enter reference for new stock

SecondReferenceln Enter second reference if required for new stock

Enter memo if required for new stock

StockAccCodeln Enter stock account code for new stock

StockAccCCln
StockAccDeptin
IssuesAccCodeln
IssuesAccCCln

IssuesAccDeptin

Narrativeln
ReferenceOut
SecondReferenceOut
MemoOut
StockAccCodeOut
StockAccCCOut
StockAccDeptOut
IssuesAccCodeOut
IssuesAccCCOut

IssuesAccDeptOut

NarrativeOut

Item Unit

Enter account cost centre if required for new stock

Enter account department if required for new stock

Enter issues account code if required for new stock

Enter issues account cost centre if required for new
stock

Enter issues account department if required for
new stock

Enter narrative if required for new stock

Enter reference for write off

Enter second reference for write off if required

Enter memo for write off if required

Enter account code for write off

Enter account cost centre for write off if required

Enter account department for write off if required

Enter issues account code for write off

Enter issues account cost centre for write off if
required

Enter issues account department for write off if
required

Enter narrative for write off if required

The additional following fields relate to the NonTraceableStock sheet

Unit of measure for item. This field is read only
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Using the Stock Take Worksheet - Entering Stock Take

Available Stock Take Lists

Before data can be entered in the stock take worksheet we must start by downloading a stock take list within
Excel. The stock take lists available in Excel are the same lists that are available to you in Sage 200.

Below image 1 shows the lists in Sage 200 and underneath image 2 the same shown in Excel.

Manage Stocktake - O X
Stocktake Lists
Stocktake Name | Warehouse Name | Last Activity Date a | Method
WAREHOUSE WAREHOUSE 2011172015 By Stock ltem Entering counts |
[]show completed stocktakes
MNew List... | Edit List... | | Print List | | Enter Values. | | Complete | | Delete |

Image 1
¥ C : e Dy load About
a @ % = 6 ompany GHJ_‘I‘ & Download @ Abou
% DraycirDemoData - & £ Product Survey
Server  View  Sync  Key Work Update Complete

Config  Audit Data Fields Offline

nnection Audit Data Stack Take

1 F 1 G 1 H Il 1 J Il K Il L
Ti © powniead - o X
| Downicad | | selectat | | Deselecti | [ cancel |
I:l ‘ D | Name ‘ Warehouse | Last Activity | Method Status
- | o e e e

[} 140467 WAREHOUSE | WAREHOUSE | 20/11/2015 | By Stock Item |Entering counts

Image 2
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Download Stock Take Lists

To view the stock take lists in Excel click on the download button from the Excel Data Bridge tab. Once clicked
a pop up window will appear with a list of all available stocktake lists.

Excel Data Bridge Q Tell me what you want to do

Vo Company: [ - 4 Download
R 2 & B

DraycirDemoData
Sync  Key Work Update Complete

Data Fields Offline
Stock Take

To download a stock take list click the tick box to the left hand side of a list and then click the Download

button in the pop up window.

@ Download

‘ T H Select Al HDeselemMH P— ‘

Warehouse ‘Last.-'-\ch'vity ‘Methnd Status

D ‘ID ‘Name
= e Lol "G " o
[ | 140467 WAREHOUSE WAREMOUSE 20/11/2015 By Stock Item | Entering counts

Confirm you wish to overwrite any current data on your sheet with the downloaded data by clicking Yes.

i @ Download
[ Download | Selectail | | Deselectan | Cancel |
|ID |Name Warehouse |Last Activity |Meﬁ10d Status
= Afc e [[s]d adc adc

140467 WAREHOUSE WAREHOUSE 20/11/2015 By Stock [tem Entering counts

I Data Import

The downloaded data will overwrite the current sheet. Continue?
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The data populated in Excel will be similar to the pop up screen in Sage 200 when you click
Enter Values. Image 3 shows the Enter Stock take Values window in Sage 200. Image 4 shows data in Excel
after downloading stocktake list.

Enter Stocktake Values — O X

Warehouse
‘Warehouse: WAREHOUSE Current stocktake date: 20/11/2015

Nominal Code To Be Used For Stockiake Variances

Code CC:  Dept Description:
Varianceaccount |v MW | | | Stocklssues-Defaut
w— |

Stock ltems

=

ABCookHoods/ AB Cooker Hoo

r
ABBuiltn/15/12  ABBuiltinCoo.. 7 18.00000 r
ABBuilin/15202  ABBuiltin Coo.. 7 18.00000 r
ABBuilin/1521/2  AB Builtin Coo... 7 18.00000 r
ABBuilinA&02  ABBuiltin Coo... 7 18.00000 r
ABBuiltin/1&12  ABBuiltinCeo.. 7 18.00000 r

Find Location...
sowarm.

Display expected quantities and variances [ ]

Image 3
A E c D 3 3 G H ) K L M N )
Stock Take
Excel -
2N Data Bridge
1
2 Details
Bl status GroupBylD Warehouse Date Name VarianceCode VarianceCC _ VarlanceDept Narrative Bin ItemCode ItemName ExpectedQuantity ActualQuantity WriteOffCategory
4| 1 WAREHOUSE20/11/2015 \WAREHOUSE 44100 12| ABBuiltin/15/0/2 AB Built-In Cookers Single-Oven/300mm/White 18 18
5 | 1 12 ABCookHoods/23 AB Cooker Hoods Standard/White 2 2
6| 1 7 ABBuiltin/15/1/2 AB Built-In Cookers Single-Oven/600mm/White 18 13
7] 1 7 ABBuIltin/15/20/: 18 18
8 | 1 7 ABBuIltin/15/21/1AB Built-In Cookers Single-Oven/550mm/White 18 18
9| 1 7 ABBuiltin/16/0/2 A 18 18
10| 1 7 ABBuiltin/16/1/2 AB In Cookers Double-Oven/600mm/White 18 18
1| 1 7 ABBuiltIn/16/20/:AB. In Cookers Double-Oven/500mm/White 18 18
12 1 7 ABBuiltin/16/21/1AB Built-In Cookers Double-Oven/550mm/White 18 18
13 1 7 MBC: ker Hoods Chi hite 2 2
14 1 7 ABFSE/12/0/2  AB Freestanding Electric 2-Ring/300mm/White 9 B
15| 1 7 ABFSE/12/1/2  AB Freestanding Electri ing/600mm/White El 9
16| 1 7 ABFSE/12/20/2  AB Freestanding Electric 2-Ring/500mm/White 9 9
17| 1 7 MBFSE/12/21/2  AB Freestanding Electric 2-Ring/550mm/White 9 9
18| 1 7 ABFSE/13/0/2  AB Freestanding Electric 3-Ring/300mm/White 9 9
12| 1 7 ABFSE/13/1/2  AB Freestanding Electric 3-Ring/600mm/White 9 9
20| 1 7 ABFSE/13/20/2  AB Freestanding Electric 3-Ring/500mm/White 9 B
Image 4
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Entering Values
Once a stock take list has been downloaded values can be entered in Excel.

If the variance account needs to be changed type in a valid code or right click the current code in
VarianceCode and select Excel Data Bridge Browse. To use the browse function it must be setup for this field.

’m’ Excel Stock Take
Data Bridge e fp s i®-w @ Browse - 0

‘Submit Select All | | Deselectll || Cancel | []insertRows

]

[coe < o = =

P T T—rTTT o o o [ o

i 02100 Freehold Property Posting
o300 Lease Froperty Fostng
04100 Plant/Machinery - Cost  Posting
04200 Plant/Machinery - Depr.  Posting
06100 Office Equipment - Cost | Posting
06200 Office Equipment - Depr, | Posting
£
oe02

st-U236GWK  Posting
08103 Vehide Cost -U237 GVK _ Posting
08104 Vehide Cost -T345 VN3 Posting
08105 Vehide Cost - Y234 KM Posting
08201 Vehide Depr -5235 GV Fosting
08202 Vehide Depr -5236 GVK _ Fosting

OoooooooooooD;

7 ABFSE/12/1/2  ABFreestanding El

|*

Using the ActualQuantity field start to enter the actual quantities for stock the same as you would enter in
the Enter Value screen in Sage 200. In instances where you would normally tick the Discrepancy box in Sage
200, enter True into the Discrepancy field in Excel. If the narrative field is utilised in Sage 200 enter the details
you would normally enter using the Narrativeltem field.

ItemName ExpectedQuantity ActualQuantity WriteOffCategory Discrepancy Narrativeltem

AB Built-In Cookers Single-Oven/300mm/White 18 16 True
| AB Cooker Hoods Standard/White 2 2 r

AB Built-In Cookers Single-Oven/600mm/White 13 10 True
AB Built-In Cookers Single-Oven/500mm/White 18 18 r
:AB Built-In Cookers Single-Oven/550mm/White 18 18 f

AB Built-In Cookers Double-Oven/300mm/White 18 18 r

AB Built-In Cookers Double-Oven/600mm/White 18 18 r
. AB Built-In Cookers Double-Oven/500mm/White 18 18 f
{AB Built-In Cookers Double-Oven/550mm/White 18 18 f

Write Off Stock

To write off stock using this template enter the category into the WriteOffCategory field in Excel, this would
normally be entered on the Write Off Stock window in Sage 200. If a browse function has been setup for this
field you can right click and select Excel Data Bridge Browse. Navigate to the WriteOff column section in Excel

TraceableWriteOff
ReferenceOut SecondReferenceOut MemoOQut StockAccCodeQut StockAccCCOut StockAccDeptOut IssuesAccCodeOut IssuesAccCCOut  IssuesAccDeptOut NarrativeOut
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These fields are replicating the fields in Sage 200 write off window as shown inimage 5 and 6
below.

Record Stock Write Off - o X
O *x @
Stock ftem
Code: [ABBuitin/15/0/2 v | Mame: | AB Buit-n Cookers singee-Ovenrsoomm v | @

Stock Location Write Off Account

\Warehouse Bin

et cuear

Alocated stock 000000

Free sock 0.00000

Quantity References

Quanty Date T

Stock unt Gacn Reference: r
st

Image 5
|
Record Stock Write Off - [u] X
e *x 0O
Stock Item
Code: | ABBuit/1SI02 v | name: | A8 Buitn Cookers Single-0 vl a

memo

Analysis code flana.

Analysis code2léna.

Analysis code 3iéna.
Nominal Posting

Code CC Depl Descripton

Stock account [v 1301 | | | stocks - Finished Gaods ]
Issues account [vasto | | [stoexissues-Defaut ]
e

Image 6

Add Stock

Stock can be added using this template. To add stock for a stock line enter TRUE into the AddNew field. Then
enter the relevant data that you would normally in the Add Stock window in Sage 200 as shown in Image 7 and
8 below.

TraceableAddstock
le AddNew UnitCostPrice Referenceln SecondReferenceln Memoln StockAccCode StockAccCCIn  StockAccDeptin  IssuesAccCode IssuesAcoCCIn  IssuesAccDeptin Narrativeln
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Record Addition of Stock - b3
O *x O
Stock ltem
Code: | ABBUHAS/ 2 v | Name: | AB Buit-in Cookers Single-Oven/soommmy + | @

Analysis | Stockng Leveis

stock Location
e

.

Allocated stock: 0.00000

Quany e

cusrtty oue: |[Ezr—
Stock unt o Reference I
Unt costprics: £ St ]
Total cost price: £ 0.00000

Il
Record Addition of Stock — X
Stock ftem
Code: | ABBuitin/ 151172 v | Name: |48 Buit-in Cookers Single-Oven/etommy v | @
Analysis Codes Memo
Name
Analysis code 1/Analy.
‘Analysis code 2/Analy.
Analysis code 3/analy
Nominal Posting
Ccode CC Dept Description
Stock account: [vizor | | | stocks - Finished Goods. ]
Issues account [vas00 [ [ [stockissues - Defaut ]
Naratve: In/ Discovery

Image 8

Update and Complete Lists

To save this data in Sage 200 click the Update button from the ExcelDataBridge tab. This does not complete
the stock take list in Sage 200. To complete the stock take list click the Complete button from the same tab.

Excel Data Bridge

“V Ty Company: _— = & Download @) About
A& RE &0

|DraycirDemoData *'| 5 Product Surve

Design Q Tell me what you want to do

View Sync  Key Work
] Audit Data Fields Offline

Update Complete

Stock Take

Data
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Group By ID

When completing multiple stocktakes in Sage 200 at once, Excel Data Bridge needs to inform Sage 200 which
lines belong together. It does this by assigning certain fields as “key fields” which can be seen by selecting the
Key Fields button from the ribbon.

KeyField properties detected:

GroupBylD

Any unique data can be entered to keep lines together, such as using numbers 1, 2, 3, 4 or letters a, b, ¢, d.

10
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Amending Templates

The worksheet templates have been created in an Excel table with the correct formatting applied.

Goods Value Tax Value Gross Value

To add additional rows, firstly locate the cell at the bottom
right hand corner of the formatted table.

Goods Value Tax Value Gross Value

Now select the cell then click and drag down on the arrow.

fr— Extra rows will be added with the correct formatting.
% g
=
O
To add additional columns, right click on the Paste Special... 0 1200
column heading where you would like your new O Smart Lookup o 2400
column to appear and select. Insert>Table = =
Columns to the left. Insert ¥ B Table Columns to the Left
Delete 3

A new column will be added, named Column 1. Rename the column in Excel, then refer to the next section
on how to map this column in designer.

(o) » |

Line Date

11
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Mapping New Columns

To add a column right click on an existing column on the template. Select Insert > Column to the left

% Cut
By Copy
%, Paste Options:

’y

}
DPREsour(EDE D OPResoul§
v i

Paste Special... <

O Smart Lookup :
Insert 3
Delete 3
Select »
Clear Contents

/A Quick Analysis
Sort >

Once a new column has been added to the template, it can be mapped to the required Sage 200 field.

Click Designer to open the mappings for the template and to locate the field to map the column to.

O % ferver
onfig

@ Map Fields

=t | E

Wersion

ode
LineNo

(OperationComponentQuantity te
P4

Download

OpRescurcefction
OpRescurceDescription
OpResourceExporiToGraphicalPlan
OpResourceFixedLength
OpR FixedQuantity F
OpResourcelineMo OpR LineNo

Click the [+ elipsis to the right of the field. The cell mapping window will appear.

Select the cell range for the column before clicking OK.

The column is now mapped and can be populated in Excel Data Bridge.

12
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Deleting Unwanted Columns

To delete an unwanted column in a template complete the following steps.

Remove the field mapping from the designer. To do this open the designer to view the mapping.

gn = — . S N > NP st o0 et
@& Map Fields o ox [eer W
onfig  Au
=t |8 Au
“ersion ~
DperationC: ineho -
DperationCompenentQuantity te r I a
Dawnload P4
OpResourceliction
OpR: Description
OpResourceExporiToGraphical Plan|
OpResourceFixedlLength OpResourceFixedLength
OpResourceFixedQuantity OpR: dQuantity
OpResourcelineNs OpRi LineNo
OpR: evel OpR inglevel
OpResourceMotes OpRi
OpResourcePhase OpResourcePhase Ilte
OpResourcePrimary OpResourcePrimary
DpR: Cuantity OpResourceQuantity
OpResourceRate OpResourceRate OpResourceReference OpResourceReference rL
OpResourceRaieCosiRateFornit_| OpResourceRateCost RateForUnit OpfRescurceResourceType OpResourceResource Type
DpResourceRateTimelnit OpResourceRate Time Unit OpR v R Y
OpResourceReference OpResourceReference FL/ OpResourceStephla R
DpResourceResourceType OpResourceResource Type OpResourceTimeDetails_Hours  [€3]37 TimeDetails_Hours |...|
OcR Oph: - OpResourceTimeDetails_Mins OpRi TimeDetails_Mins
OpResourceStepNo OpResourceTimeDetails_Secs R TimeDetails_Secs
OpResource TimeDetails_Hours |...| ‘OpResourceTimelnitDetails_Quani| OpR TimeUnit Details_Quant
OpR TimeDetails Mins OpResourceTimeUnitDetails_Timel OpResource Time Unit Details_Timell
OpRi TimeDetails_Secs
OpResourceTimelnitDetails_Quani OpRe Time Unit Details_Quant
OpResourceTimeUnitDetzils_Timel| OpResource Time Unit Details_Timel

Clear the data in mapping field. Close the designer then click Validate Design to check for errors.

Lastly remove the column from the template. Right click the column heading and select Delete>Table
Columns.

CB ce cD
&% Cut
B3 Copy
ry Paste Options:
.

0

Paste Special...

Insert
Delete

Clear Contents

Time Details Format Cells...

esourceCostRateUnit Column Width...

Hide

Unhide

13
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Setup Browse Function

Some fields in Excel Data Bridge can be setup with browse functionality. To setup follow the steps below.
1. Click ‘Define Browse’ from configuration area of ribbon
2. Enter arelevant name

3. Choose ‘Select Pre-defined browse’

ranced~ [ — 2 Logged In - N o Comg.
] EL'E» m Blogou: @\ E BB @ e @ Browse Wizard - o X
Define Map Configure  Auto - Sever | View | Sne  Key Work
Browses Browse Auto Browse Browse Config ~ Audit Data Fields Offline
Configuration Connection Audit 1 m Excel
» - A
B Browse Wizard - o x Data Brldqe

— m Excel
- bd "
Data Brldqe J  Erterancwbrowse name, the name wil be validated to ensure i does not aready exist

'a Choose to create anew browse definiion sither based on a pre defined browse o specify a range of fixed
values. Or choose to edit a browse defintion.

Bronss ame

Make a selection

@ Create a new browse defirition

Edit an exisfing browse:

definition

4. Select browse from the list
5. Select fields and data you would like to show to users

6. Open designer tab. Expand field required and set browselist to the one just created.

@ Mapbrowse - B X @ Map Fields - o %
AFy
_’m_' Excel =]
i -
Data Bridge SellngPicel.nit
DatePror|  Eaaletls 0
ShowOnCustomerD
ShowDnFickingList,
Use the drop down fields below to assign the field range that is populated by the data in the appropriate UnitDiscount
column when a row from the browse is selected UnitDiscountPercen
Warehouse
[ Name On Order In Stock Al “blanic
4 |W""‘"“se |VI’N°"E’ ‘VI’N"“’ ‘VI’N‘ KeyField False
< > Mandatory False
v
Browselist
Select a browse from the drop down list
<Back | [ Met> | [ Cancel
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